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Module 1 
Introduction to Windows Server 2008 Hyper-V 

Contents: 
Lab Answer Keys 2 
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Lab Answer Keys 
Lab: Install Hyper-V and Perform Initial Configuration 

Exercise 1: Install Hyper-V 

► Task1: Enabling the Hyper V role in Windows Server 2008 

1. As part of setup, your instructor has ensured that the computer has hardware assisted virtualization 
with the No-Execute Bit enabled. 

2. Log on to 6422-Hyper-V## as Contoso##\Administrator. To ensure each classroom has a unique 
computer name and domain, the Hyper-V servers have been assigned a two-digit number. When 
typing the computer name and domain throughout these labs, be sure to include these numbers. 

3. On the Start menu, click Administrative Tools | Server Manager. 

4. The Server Manager window opens. Maximize the window. 

5. In the details pane, scroll down, and then click Add Roles. 

6. The Add Roles Wizard appears. Click Next. 

7. On the Select Server Roles page, select Hyper-V, and then click Next. 

8. On the Hyper-V page, click Next. 

9. On the Create Virtual Network page, select Local Area Connection, and then click Next. 

10. On the Confirm Installation Selections page, click Install. 

11. On the Installation Results page, click Close. 

12. The Add Roles Wizard dialog box appears. Click Yes. 

13. After the server restarts, log on as the domain administrator. 

14. The Resume Configuration Wizard appears. Review the messages, and then click Close. 

Results: After this exercise, you should have successfully installed the Hyper-V role. 

Exercise 2: Explore the Hyper-V Management Console 

► Task 1: Exploring Hyper-V Manager 

1. On the Start menu, click Administrative Tools | Hyper-V Manager. 

2. The Hyper-V Manager window opens. Maximize the window. 

3. In the console tree, click Hyper-V Manager. 

4. In the details pane, review the information in the Introduction and Resources sections. 

5. In the Actions pane, click Connect to Server. 

6. The Select Computer dialog box appears. Click Cancel. 

7. In the console tree, click 6422-HYPER-V. Review the sections of the details pane. 

8. In the Actions pane, click Hyper-V Settings. 

9. The Hyper-V Settings dialog box appears. Review the server level settings for Hyper-V. Click Cancel. 



 Introduction to Windows Server 2008 Hyper-V 1-3 

 

10. In the Actions pane, click Virtual Network Manager. 

11. The Virtual Network Manager dialog box appears. Review the settings for Virtual Networks. Click 
Cancel. 

12. In the Actions pane, click New. Review the wizards for creating Virtual Machine, Hard Disk and 
Floppy Disk. 

13. In the Actions pane, click Import Virtual Machine. You can only import Virtual Machines that have 
been created and exported in Hyper-V. 

14. The Imported Virtual Machines dialog box appears. In the Import Path field, type 
E:\Mod01\Labfiles\SEA-SQL-01, and then click Import. 

15. In Virtual Machines pane, click SEA-SQL-01. 

16. In the Actions pane, click Start, and then click Connect. 

17. The SEA-SQL-01 on 6422-Hyper-V – Virtual Machine Connection window opens. Explore the menu 
and toolbar options. Experiment with working on the virtual machine. When finished, close this 
window. 

Results: After this exercise, you should have become familiar with Hyper V Manager. 
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Module 2 
Configure Hyper-V Settings and Virtual Networks 

Contents: 
Lab Answer Keys 2 
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Lab Answer Keys 
Lab: Configuring Hyper-V and Virtual Networks 

Exercise 1: Configure Hyper-V Server Settings 

► Task1: Configuring Hyper-V server settings 

1. Restore Hyper-V Manager. 

2. In the Actions pane, click Hyper-V Settings. 

3. The Hyper-V Settings dialog box appears. In the Specify the default folder to store virtual hard 
disk files field, type E:\Hyper-V\Virtual Hard Disks. 

4. In the left pane, click Virtual Machines. 

5. In the Specify the default folder to store virtual machine configuration files field, type E:\Hyper-
V. Click OK. 

6. In the Actions pane, click New | Virtual Machine. 

7. The New Virtual Machine Wizard appears. Click Next. 

8. On the Specify Name and Location page, in the Name field, type SEA-SQL-02, and then click Next. 

9. On the Assign Memory page, in the Memory field, type 1024. Click Next. 

10. On the Configure Networking page, in the Connection list, click the Virtual Network Adapter. 
Click Next. 

11. On the Connect Virtual Hard Disk page, click Next. 

12. On the Installation Options page, click Next. 

13. On the Completing the New Virtual Machine Wizard page, click Finish. 

14. In the Virtual Machines pane, click SEA-SQL-02. 

15. In the Actions pane, under SEA-SQL-02, click Settings. 

16. The Settings for SEA-SQL-02 dialog box appears. In the left pane, under Hardware, click Memory. 
In the Memory field, type 512. 

17. In the left pane, click Processor. In the Number of logical processors list click 2. 

18. Review the settings under Resource control. Review the information available through the More 
about resource control link. Click OK. 

Results: After this exercise, you will have successfully configured the Hyper-V Server Settings and 
created a new virtual machine. 

Exercise 2: Configure Hyper-V Virtual Networks 

► Task 1: Configuring Hyper-V virtual network settings 

1. In the Actions pane, click Virtual Network Manager. 

2. In the left pane, click the existing Virtual Network. 

3. In the Name field, type Enterprise. 

4. Under Connection type, click External. Click the physical network adapter, and then click Apply. 
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5. If the Apply Networking Changes dialog box appears, click Yes. 

6. In the left pane, click New virtual network. 

7. In the right pane, click Internal, and then click Add. 

8. In the Name field, type Test Environment. 

9. Under Connection type, click Internal only. Click Apply. 

10. If the Apply Networking Changes dialog box appears, click Yes. 

11. In the left pane, click New virtual network. 

12. In the right pane, click Private, and then click Add. 

13. In the Name field, type Isolated. 

14. Under Connection type, click Private virtual machine network. Click OK. 

15. If the Apply Networking Changes dialog box appears, click Yes. 

16. In the Virtual Machines pane, click SEA-SQL-02. 

17. In the Actions pane, under SEA-SQL-02, click Settings. 

18. The Settings for SEA-SQL-02 dialog box appears. In the left pane, under Hardware, click Network 
Adapter. 

19. In the right pane, in the Network list, click Test Environment. 

20. Review the additional settings available, and then click OK. 

Results: After this exercise, you will have configured Hyper-V Virtual Network Settings 
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Module 3 
Hyper-V Remote Administration 

Contents: 
Lab Answer Keys 2 
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Lab Answer Keys 
Lab: Accessing and Managing Hyper-V Remotely 

Exercise 1: Configure the Windows Firewall 

► Task1: Configuring the Windows Firewall 

1. On the Start menu, click Administrative Tools | Windows Firewall with Advanced Security. 

2. The Windows Firewall with Advanced Security window opens. Maximize the window. 

3. In the console tree, click Inbound Rules. 

4. In the details pane, double-click Hyper-V - WMI (Async-In). Review the settings, and then click 
Cancel. 

5. Double-click Hyper-V - WMI (DCOM-In). Review the settings, and then click Cancel. 

6. Double-click Hyper-V - WMI (TCP-In). Review the settings, and then click Cancel. 

7. Double-click Hyper-V (RPC). Review the settings, and then click Cancel. 

8. Double-click Hyper-V (RPC-EPMAP). Review the settings, and then click Cancel. 

9. Double-click Hyper-V (SPL-TCP-In). Review the settings, and then click Cancel. 

10. Double-click Hyper-V Management Clients - WMI (Async-In). Review the settings, and then click 
Cancel. 

11. Double-click Hyper-V Management Clients - WMI (DCOM-In). Review the settings, and then click 
Cancel. 

12. Double-click Hyper-V Management Clients - WMI (TCP-In). Review the settings, and then click 
Cancel. 

13. In the console tree, click Outbound Rules. 

14. In the details pane, double-click Hyper-V - WMI (TCP-Out). Review the settings, and then click 
Cancel. 

15. Double-click Hyper-V Management Clients - WMI (TCP-Out). Review the settings, and then click 
Cancel. 

16. Close Windows Firewall with Advanced Security. 

Results: After this exercise, you should have reviewed the Windows Firewall with Advanced Security 
settings for remotely managing Hyper-V. 

Exercise 2: Install the Hyper-V Manager on Windows Vista 

► Task 1: Import and start SEA-WRK-001 
1. Restore Hyper-V Manager. 

2. In the Actions pane, click Import Virtual Machine. 

3. The Import Virtual Machine dialog box appears. In the Import path field, type 
E:\Mod03\Labfiles\SEA-WRK-001. Click Import. 

4. In the details pane, click SEA-WRK-001. 
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5. In the Actions pane, click Settings. 

6. The Settings for SEA-WRK-001 dialog box appears. In the left pane, click Network Adapter. 

7. In the right page, in the Network list, click Enterprise. Click OK. 

8. In the Actions pane, click Start. 

► Task 2: Installing the Hyper-V manager on Windows Vista 

1. In the Actions pane, click Connect. 

2. The SEA-WRK-001 on local host window opens. Perform the following steps within the SEA-WRK-
001 virtual machine. 

3. On the Start menu, right-click Computer, and then click Properties. 

4. The System window opens. Maximize the window. 

5. Under Windows edition, confirm that Service Pack 1 is installed. 

6. In the address bar, type C:\Mod03\Labfiles, and then press ENTER. 

7. Double-click Windows6.0-KB952627-x86. 

8. The User Account Control (UAC) dialog box appears. Click Continue. 

9. The Windows Update Standalone Installer dialog box appears. Click OK. 

10. The Download and Install Updates dialog box appears. When installation completes, click Close. 

Results: After this exercise, you should have installed the Hyper-V Manager on Windows Vista. 

Exercise 3: Connect to the Hyper-V Server Remotely 

► Task 1: Connecting to the Hyper-V server remotely 

1. On the Start menu, click Control Panel. 

2. The Control Panel window opens. Maximize the window. 

3. Click System and Maintenance, and then click Administrative Tools. 

4. Double-click Hyper-V Manager. 

5. The UAC dialog box appears. Click Continue. 

6. The Hyper-V Manager window opens. Maximize the window. 

7. In the Actions pane, click Connect to Server. 

8. The Select Computer dialog box appears. Click Another Computer. 

9. In the Computer Name field, type 6422-HYPER-V##. Click OK. 

10. Review the message in the Virtual Machines pane. In order to manage Hyper-V remotely, you must 
connect using a domain user account that has permissions to manage the Hyper-V server. 

11. In the SEA-WRK-001 on localhost window, click the Shutdown toolbar button. 

12. The Shut Down Machine dialog box appears. Click Shut Down. 

13. After the operating system shuts down, close SEA-WRK-001 on localhost. 

Results: After this exercise, you should have connecting to the Hyper-V server remotely. 
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Module 4 
Creating Virtual Hard Drives and Virtual Machines 

Contents: 
Lab Answer Keys 2 
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Lab Answer Keys 
Lab: Creating Virtual Hard Drives and Virtual Machines 

Exercise 1: Creating New Virtual Hard Drives 

► Task1: Creating a new virtual hard drive 

1. Restore Hyper-V Manager. 

2. In the Actions pane, click New | Hard Disk. 

3. The New Virtual Hard Disk Wizard appears. Review the information available through the More 
about virtual hard disks link. Click Next. 

4. On the Choose Disk Type page, review the descriptions under each virtual hard drive type. 

5. Click Dynamically expanding, and then click Next. 

6. On the Specify Name and Location page, in the Name field, type SEA-WEB-01. 

7. Next to the Location field, click Browse. 

8. The Select Folder dialog box appears. Browse to E:\Hyper-V\Virtual HardDisks\, and then click OK. 
Click Next. 

9. On the Configure Disk page, click Create a new blank virtual hard disk. 

10. In the Size field, type 250, and then click Next. 

11. On the Completing the New Virtual Hard Disk Wizard page, review the settings, and then click 
Finish. 

12. On the Start menu, click Computer. 

13. Navigate to E:\Hyper-V\Virtual Hard Disks. Verify the SEA-WEB-01.vhd file exists and note the size 
of the file. 

► Task 2: Replicating an existing virtual hard drive 

1. Right-click SEA-WEB-01.vhd, and then click Copy. 

2. On the Edit menu, click Paste. 

3. Right-click SEA-WEB-01 – Copy.vhd, and then click Rename. 

4. Type SEA-WEB-02, and then press ENTER. 

5. Minimize Windows Explorer. 

► Task 3: Creating a new virtual hard drive from a physical hard drive 

1. Restore Hyper-V Manager. 

2. In the Actions pane, click New | Hard Disk. 

3. The New Virtual Hard Disk Wizard appears. Click Next. 

4. On the Choose Disk Type page, click Next. 

5. On the Specify Name and Location page, in the Name field, type SEA-Hyper-V-01.vhd. Click Next. 

6. On the Configure Disk page, click Copy the contents of the specified physical disk. 
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7. Restore Server Manager. 

8. In the console tree, expand Storage, and then click Disk Management. 

9. In the details pane, verify that the C:\ drive is on Disk 0. 

10. Minimize Server Manager. 

11. In the Physical Hard Disk list, click \\.\PHYSICALDRIVE0. Click Next. 

12. On the Completing the New Virtual Hard Disk Wizard page, review the settings, and then click 
Finish. 

13. Restore Windows Explorer. 

14. Verify the SEA-Hyper-V.vhd file exists and note the size of the file. It may take several minutes for 
the physical hard drive to be replicated to the Virtual Hard Disk (VHD) file. Press F5 to refresh as 
necessary. Depending on the size of physical drive, this process may take hours to complete. 

15. Minimize Windows Explorer. 

16. In the Creating the new virtual hard disk dialog box, click Cancel. 

17. The New Virtual Hard Disk Wizard dialog box appears. Click Close, and then click Cancel. 

Results: After this exercise, you should have 3 VHD files. Cancel the creation of SEAHyper-V-01.vhd 
creation. 

Exercise 2: Creating New Virtual Machines 

► Task 1: Create the SEA-WEB-01 virtual machine 

1. Restore Hyper-V Manager. 

2. In the Actions pane, click New | Virtual Machine. 

3. The New Virtual Machine Wizard appears. Review the Before You Begin information, and then 
click Next. 

4. On the Specify Name and Location page, in the Name field, type SEA-WEB-01. Click Next. 

5. On the Assign Memory page, in the Memory field, type 512. Click Next. 

6. On the Configure Networking page, in the Connection list, click Test Environment. Click Next. 

7. On the Connect Virtual Hard Disk page, click Use an existing virtual hard disk. 

8. Click Browse. 

9. The Open dialog box appears. Click SEA-WEB-01.vhd, and then click Open. 

10. Click Next. 

11. On the Completing the New Virtual Machine Wizard page, review the settings. 

12. Click Finish. 

► Task 2: Add the second VHD to SEA-WEB-01 

1. In the Virtual Machines pane, click SEA-WEB-01. 

2. In the Actions pane, under SEA-WEB-01, click Settings. 

3. The Settings for SEA-WEB-01 dialog box appears. In the left pane, click IDE Controller 0. 
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4. In the right pane, click Hard Drive, and then click Add. 

5. Under Media, click Browse. 

6. The Open dialog box appears. Click SEA-WEB-02.vhd, and then click Open. 

7. Click Apply. 

► Task 3: Mount the operating system installation media 

1. In the left pane, under IDE Controller 1, click DVD Drive. 

2. In the right pane, under Media, click Image file. 

3. Click Browse. 

4. The Open dialog box appears. Navigate to E:\Mod04\Labfiles. 

5. Click 6001.18000.080118-1840_amd64fre_Server_en-us-KRMSXFRE_EN_DVD.iso, and then click 
Open. 

6. In the Settings for SEA-WEB-01 dialog box, click OK. 

► Task 4: Connect to the Virtual Machine and install Windows Server® 2008 

1. In the Virtual Machines pane, click SEA-WEB-01. 

2. In the Actions pane, click Start. 

3. In the Actions pane, click Connect. 

4. The Virtual Machine may be unable to capture the mouse until the Hyper-V Integration Services are 
installed. If this is the case, use the keyboard to start the Windows Server 2008 installation. 

5. The SEA-WEB-01 on 6422-Hyper-V – Virtual Machine Connection window opens. When the Install 
Windows wizard appears, press ENTER twice. 

6. On the Type your product key for activation page, click Next. 

7. The Install Windows dialog box appears. Review the message, and then click No. 

8. On the Select the edition of Windows that you purchased page, click Windows Server 2008 
Enterprise (Server Core Installation). 

9. Select I have selected the edition of Windows that I purchased, and then click Next. 

10. On the Please read the license terms page, select I accept the license terms, and then click Next. 

11. On the Which type of installation do you want page, click Custom (advanced). 

12. On the Where do you want to install Windows page, click Next. The installation will now 
complete. 

13. Close SEA-WEB-01 on localhost. 

Results: After this exercise, you should have one virtual machine created from the previous exercises 
VHDs, and Windows Server 2008 installing on the VM. 
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Module 5 
Virtual Machine Settings, Snapshots, and High Availability 

Contents: 
Lab Answer Keys 2 
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Lab Answer Keys 
Lab: Managing Virtual Machines 

Exercise 1: Configure Virtual Machine Settings 

► Task1: Configure critical virtual machine settings 

1. Restore Hyper-V Manager. 

2. In the Virtual Machines pane, click SEA-WEB-01. 

3. In the Action pane, under SEA-WEB-01, click Settings. 

4. The Settings for SEA-WEB-01 dialog box appears. In the left pane, under Hardware, click 
Processor. 

5. Review the information available through the More about virtual processors and More about 
resource control links. 

6. In the Virtual machine reserve (percentage) field, type 20. 

7. In the Virtual machine limit (percentage) field, type 80. 

8. In the Relative weight field, type 75. 

9. Click Apply. 

10. In the left pane, under Management, click Automatic Start Action. 

11. In the right pane, click Always start this virtual machine automatically. 

12. In the left pane, under Management, click Automatic Stop Action. 

13. In the details pane, review the settings. 

14. Click OK. 

15. In the Virtual Machines pane, click SEA-SQL-01. 

16. In the Action pane, under SEA-SQL-01, click Settings. 

17. The Settings for SEA-SQL-01 dialog box appears. In the left pane, under Hardware, click Processor. 

18. In the Virtual machine reserve (percentage) field, type 20. 

19. In the Virtual machine limit (percentage) field, type 80. 

20. In the Relative weight field, type 50. 

21. Click Apply 

22. In the left pane, under Management, click Automatic Start Action. 

23. In the right pane, click Always start this virtual machine automatically. 

24. In the left pane, under Management, click Automatic Stop Action. 

25. In the right pane, click Shut down the guest operating system. 

26. Click OK. 

► Task 2: Configure non-critical virtual machine settings 

1. In the Virtual Machines pane, click SEA-WRK-001. 
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2. In the Action pane, under SEA-WRK-001, click Settings. 

3. The Settings for SEA-WRK-001 dialog box appears. In the left pane, under Hardware, click 
Processor. 

4. In the Virtual machine reserve (percentage) field, type 0. 

5. In the Virtual machine limit (percentage) field, type 20. 

6. In the Relative weight field, type 25. 

7. Click Apply. 

8. In the left pane, under Management, click Automatic Start Action. 

9. In the right pane, click Nothing. 

10. In the left pane, under Management, click Automatic Stop Action. 

11. In the right pane, click Turn off the virtual machine. 

12. Click OK. 

Results: After this exercise, you will have successfully configured the VM settings for the virtual machines. 

Exercise 2: Monitor Hyper-V Performance 

► Task 1: Adding counters to the Performance Monitor 

1. On the Start menu, click Administrative Tools | Reliability and Performance Monitor. 

2. The Reliability and Performance Monitor window opens. Maximize the window. 

3. In the console tree, click Performance Monitor. 

4. In the details pane, review the Counter % Processor Time. 

5. Click the Add toolbar button, the green plus sign (+). 

6. The Add Counters dialog box appears. Select Show description. 

7. In the Available counters list, scroll up and expand Hyper-V Hypervisor. 

8. Click Logical Processors, and then click Add >>. 

9. Click Partitions, and then click Add >>. 

10. Click Virtual Processors, and then click Add >>. 

11. Expand Hyper-V Hypervisor Logical Processor. 

12. Click % Guest Run Time, and then click Add >>. 

13. Click % Hypervisor Run Time, and then click Add >>. 

14. Click % Total Run Time, and then click Add >>. 

15. Click OK. 

► Task 2: Using the Performance Monitor 

1. Restore Hyper-V Manager. 

2. In the Virtual Machines pane, right-click SEA-SQL-02, and then click Start. 

3. Right-click SEA-WEB-01, and click Shut Down. 



5-4                Implementing and Managing Windows Server® 2008 Hyper-V™ 

4. The Shut Down Machine dialog box appears. Click Shut Down. 

5. When the state of SEA-WEB-01 is Off, in the Actions pane, click Settings. 

6. The Settings for SEA-WEB-01 dialog box appears. In the left pane, click Processor. 

7. In the Number of logical processors list, click 2. 

8. Click OK. 

9. In the Actions pane, click Start. 

10. Restore Reliability and Performance Monitor. 

11. Review the graph. 

12. Click the Change Graph Type toolbar button (or press CTRL+G) to alternate the type of graphs. 

Results: After this exercise, you will have experience with the new Hyper-V performance monitor 
counters. 
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Module 6 
Migration of Virtual Machines to Hyper-V 

Contents: 
Lab Answer Keys 2 
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Lab Answer Keys 
Lab: Managing Virtual Machines 

Exercise 1: Migrate Existing Virtual Machines to Hyper-V 

► Task1: Copy the Virtual Server 2005 virtual hard disk (VHD) files to Hyper-V 

1. Restore Windows Explorer. 

2. Browse to E:\Mod6\Labfiles. 

3. Click WS03 NoVMAdd.vhd, and then press CTRL+click WS03 VMAdd.vhd. 

4. On the Edit menu, click Copy. 

5. Browse to E:\Hyper-V\Virtual Hard Disks. 

6. On the Edit menu click Paste. 

► Task 2: Create Hyper-V VMs 

1. Restore Hyper-V Manager. 

2. In the Actions pane, click New | Virtual Machine. 

3. The New Virtual Machine Wizard appears. Click Next. 

4. On the Specify Name and Location page, in the Name field, type SEA-SRV-01. Click Next. 

5. On the Assign Memory page, in the Memory field, type 256. Click Next twice. 

6. On the Connect Virtual Hard Disk page, click Use an existing virtual hard disk. 

7. Click Browse. 

8. The Open dialog box appears. Double-click WS03 VMAdd.vhd. 

9. Click Finish. 

10. In the Actions pane, click New | Virtual Machine. 

11. The New Virtual Machine Wizard appears. Click Next. 

12. On the Specify Name and Location page, in the Name field, type SEA-SRV-02. Click Next. 

13. On the Assign Memory page, in the Memory field, type 256. Click Next twice. 

14. On the Connect Virtual Hard Disk page, click Use an existing virtual hard disk. 

15. The Open dialog box appears. Double-click WS03 NoVMAdd.vhd. 

16. Click Finish. 

17. In the Virtual Machines pane, click SEA-WEB-01, and then press CTRL+click SEA-WRK-001. 

18. In the Actions pane, click Shut Down. 

19. In the Virtual Machines pane, click SEA-SRV-01, and then press CTRL+click SEA-SRV-02. 

20. In the Actions pane, click Start. 

Results: After this exercise, you should have two virtual machines created. One will have the VM 
Additions still installed and the other will not. 
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Exercise 2: Troubleshoot Issues on the Migrated VMs 

► Task 1: Migrate the SEA-SRV-01 VM to Hyper-V 

1. In the Virtual Machines pane, click SEA-SRV-01. 

2. In the Actions pane, click Connect. 

3. The SEA-SRV-01 on localhost window opens. After the server boots, click the CTRL+ALT+DEL toolbar 
button. 

4. Click the mouse pointer inside the window. 

5. Review the message at the bottom of the window. 

6. Perform the remaining steps in this task within the SEA-SRV-01 Virtual Machine. 

7. If the Service Manager dialog box appears, click OK. 

8. Log on as Administrator. In the Password field, type Pa$$w0rd. 

9. The Windows Protection Activation dialog box appears. Click No. 

10. The New Hardware Wizard dialog box appears. Click Cancel. 

11. Press RIGHTALT+LEFT ARROW to release the mouse. 

12. On the Action menu, click Insert Integration Services Setup Disk. 

13. The Virtual Machine Additions Detected dialog box appears. Review the message, and then click 
OK. 

14. On the Start menu, click Control Panel | Add or Remove Programs. 

15. The Add or Remove Programs window opens. Click Virtual Machine Additions, and then click 
Remove. 

16. The Add or Remove Programs dialog box appears. Click Yes. 

17. The Virtual Machine Additions dialog box appears. Click Yes. 

18. When the virtual machine reboots, log on as Administrator. In the Password field, type Pa$$word. 

19. If the Service Manager dialog box appears, click OK. 

20. The Windows Protection Activation dialog box appears. Click No. 

21. The New Hardware Wizard dialog box appears. Click Cancel. 

22. On the desktop, double-click My Computer. 

23. Double-click Integration Services Setup (D:). 

24. The HAL Upgrade Required dialog box appears. Review the message, and then click OK. 

25. The Restart Required dialog box appears. Click Yes. 

26. When the virtual machine restarts, log on as Administrator. In the Password field, type Pa$$w0rd. 

27. The Windows Protection Activation dialog box appears. Click No. 

28. The New Hardware Wizard dialog box appears. Click Cancel. 

29. The Hyper-V Integration Services dialog box appears. This process may take several minutes to 
complete. 
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30. The Files Needed dialog box appears. In the Copy files from field, type C:\Win2k3\I386, and then 
click OK. 

31. The Installation Complete dialog box appears. Review the message, and then click Yes. 

32. When the virtual machine reboots, log on as Administrator. In the Password field, type Pa$$w0rd. 

33. The Windows Protection Activation dialog box appears. Click No. 

34. The Virtual Machine is now ready for use on the Hyper-V server. 

35. Close the SEA-SRV-01 on localhost – Virtual Machine Connection window. 

► Task 2: Migrate the SEA-SRV-02 VM to Hyper-V 

1. Restore Hyper-V Manager. 

2. In the Virtual Machines pane, double-click SEA-SRV-02. 

3. The SEA-SRV-02 on localhost window opens. After the server boots, click the CTRL+ALT+DEL 
toolbar button. 

4. Click the mouse pointer inside the window. 

5. Perform the following steps using the keyboard within the SEA-SRV-01 Virtual Machine. 

6. Log on as Administrator. In the Password field, type Pa$$w0rd. 

7. If the Service Manager dialog box appears, click OK. 

8. The Windows Protection Activation dialog box appears. Click No. 

9. The New Hardware Wizard dialog box appears. Click Cancel. 

10. Press CTRL+ALT+LEFT ARROW. In the SEA-SRV-02 on localhost window, on the Action menu, click 
Insert Integration Services Setup Disk. 

11. The HAL Upgrade Required dialog box appears. Review the message, and then click OK. 

12. The Restart Required dialog box appears. Review the message, and then click OK. 

13. When the virtual machine restarts, log on as Administrator. In the Password field, type Pa$$w0rd. 

14. If the Service Manager dialog box appears, click OK. 

15. The Windows Protection Activation dialog box appears. Click No. 

16. The New Hardware Wizard dialog box appears. Click Cancel. 

17. The Files Needed dialog box appears. In the Copy files from field, type C:\Win2k3\I386, and then 
click OK. 

18. The Installation Complete dialog box appears. Review the message, and then click Yes. 

19. When the virtual machine restarts, log on as Administrator. In the Password field, type Pa$$w0rd. 

20. The Windows Protection Activation dialog box appears. Click No. 

21. The Virtual Machine is now ready for use on the Hyper-V server. 

22. Close the SEA-SRV-02 on localhost – Virtual Machine Connection window. 

Results: After this exercise, you should have two virtual machines working with Hyper-V Integration 
Services installed. 
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Module 7 
Introduction to System Center Virtual Machine Manager 

Contents: 
Lab Answer Keys 2 
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Lab Answer Keys 
Lab: Using VMM to Manage Hyper-V 

Exercise 1: Configure VMM 

► Task1: Open Virtual Machine Manager Administrator Console 

1. On the Start menu, click All Programs | Microsoft System Center | Virtual Machine Manager 
2008 | Virtual Machine Manager Administrator Console. 

2. The Connect to Server dialog box appears. Click Connect. 

► Task 2: Add a new host group 

1. In the Actions pane, click New host group. 

2. Type Contoso, and then press ENTER. 

► Task 3: Add a Hyper-V host 

1. In the Actions pane, click Add host. 

2. The Add Hosts wizard appears. In the Password field, type Pa$$w0rd, and then click Next. 

3. On the Select Host Servers page, in the Host server name field, type 6422-Hyper-V##, and then 
click Add. 

4. In the Selected servers list, click 6422-Hyper-V##.contoso.com, and then click Next. 

5. The Virtual Machine Manager dialog box appears. Review the message, and then click Yes. 

6. On the Configuration Settings page, in the Add the selected new hosts to the following host 
group list, expand All Hosts, and then click Contoso. 

7. Click Next. 

8. On the Host Properties page, in the Add the following paths field, type E:\Hyper-V. Click Add, 
and then click Next. 

9. On the Summary page, click Add Hosts. 

10. The Jobs window opens. Maximize the window. Review the status and description of each job. When 
the jobs finish, close the Jobs window. 

11. In the details pane, under 6422-Hyper-V##.Contoso.com, review the CPU, Memory, Storage, 
Operating system, Virtualization software, and Virtual machines information. It may take several 
minutes for this information to populate. 

Results: After this exercise, you should have added 6422-Hyper-V to the Contoso host group in the 
Virtual Machine Manager Administrator Console. 

Exercise 2: Manage Hosts 

► Task 1: View host information 

1. In the details pane, double-click 6422-Hyper-V##.Contoso.com. 

2. The Host Properties for 6422-Hyper-V##.Contoso.com dialog box appears. Review the 
information available for this VM Host on each of the tabs. 
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3. Click Cancel. 

► Task 2: View virtual machines 

1. In the left pane, click Virtual Machines. 

2. In the details pane, double-click SEA-WEB-01. 

3. The Virtual Machine Properties for SEA-WEB-01 dialog box appears. Review the information 
available for this VM on each of the tabs. 

4. Click Cancel. 

5. In the details pane, click SEA-SRV-01, and then press CTRL+click SEA-SRV-02. 

6. In the Actions pane, click Shut down. 

7. The Virtual Machine Manager dialog box appears. Review the message, and then click Yes. 

► Task 3: Create virtual networks 

1. In the left pane, click Hosts. 

2. In the details pane, double-click 6422-Hyper-V.contoso.com. 

3. The Host Properties for 6422-Hyper-V##.Contoso.com dialog box appears. Click the Networking 
tab. 

4. Click Add. 

5. In the Name field, type VMM Network. 

6. Under Network bindings, click Physical network adapter. 

7. Select Host access. 

8. Click OK. 

9. The Virtual Machine Manager dialog box appears. Review the message, and then click Yes. 

Results: After this exercise, you should have created a network named VMM Network. 

Exercise 3: Create a New Virtual Machine 

► Task 1: Create a new virtual machine 

1. In the Actions pane, click New virtual machine. 

2. The New Virtual Machine wizard appears. Click Create the new virtual machine with a blank 
virtual hard disk, and then click Next. 

3. On the Virtual Machine Identity page, in the Virtual machine name field, type LON-DC-01. Click 
Next. 

4. On the Configure Hardware page, in the Size field, type 20. 

5. In the left pane, under Hardware Profile, click Memory. 

6. In the Virtual machine memory field, type 256. 

7. In the left pane, under Hardware Profile, click Processor. 

8. Under CPU, in the Number of CPUs list, click 2. 
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9. In the CPU type list, click 1.80 GHz Pentium 4. 

10. Click Next. 

11. On the Select Destination page, review the options, and then click Next. 

12. On the Select Host page, click 6422-Hyper-V##.Contoso.com. 

13. Review the tabs under Details, and then click Next. 

14. On the Select Path page, click Next. 

15. On the Select Networks page, in the Virtual Network list, click Internal Network-VMM Network. 

16. Click Next. 

17. On the Additional Properties page, in the Action when physical server stops list, click Shut down 
guest OS. 

18. Under Operating system, in the Specify the operating system you will install in the virtual 
machine list, review the available options. Click Windows Server 2003 Enterprise x64 Edition. 

19. Click Next. 

20. On the Summary page, click Create. 

21. The Jobs window opens. Review the jobs required to create the virtual machine. When all the jobs 
complete, close the Jobs window. 

Results: After this exercise, you should have created a new virtual machine named LON-DC-01. 

Exercise 4: Create a VM from an Existing Hard Disk 

► Task 1: Create a new VM from an existing hard disk 

1. In the Actions pane, click New virtual machine. 

2. The New Virtual Machine wizard appears. Click Browse. 

3. The Select Virtual Machine Source dialog box appears. Click Blank Disk – Large, and then click OK. 
Click Next. 

4. On the Virtual Machine Identity page, in the Virtual machine name field, type LON-DC-02, and 
then click Next. 

5. On the Configure Hardware page, click Next. 

6. On the Select Destination page, click Next. 

7. On the Select Host page, click Next. 

8. On the Select Path page, click Next. 

9. On the Select Networks page, in the Virtual Network list, click VMM Network. 

10. Click Next. 

11. On the Additional Properties page, click Next. 

12. On the Summary page, click Create. 

13. The Jobs window opens. Review the jobs required to create the virtual machine. When all the jobs 
complete, close the Jobs window. 
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Results: After this exercise, you should have created a new virtual machine named LON-DC-02. 

Exercise 5: Convert a VMware Virtual Machine 

► Task 1: Copy files to library share 

1. On the Start menu, click Computer. 

2. The Windows Explorer window opens. Navigate to E:\ Mod07\Labfiles. 

3. Click SEA-APP-01.vmdk, and then CTRL-click Windows Server 2003 Enterprise Edition.vmx. 

4. On the Edit menu, click Copy. 

5. In the address bar, type \\6422-Hyper-V##.contoso.com\msscvmmlibrary, and then press ENTER. 

6. On the Edit menu, click Paste. 

7. Wait for the copy process to complete. 

8. Close Windows Explorer. 

► Task 2: Refresh library 

1. Restore Virtual Machine Manager. 

2. In the left pane, click Library. 

3. In the Library Servers pane, click 6422-Hyper-V.Contoso.com. 

4. In the Actions pane, Under Library Server, click Refresh. 

► Task 3: Convert virtual machine 

1. In the Actions pane, click Convert virtual machine. 

2. The Convert Virtual Machine Wizard appears. Click Browse. 

3. The Select Virtual Machine Source dialog box appears. Click SEA-APP-01, and then click OK. Click 
Next. 

4. On the Virtual Machine Identity page, click Next. 

5. On the Virtual Machine Configuration page, in the Memory field, type 256. Click Next. 

6. On the Select Host page, click 6422-Hyper-V##.Contoso.com, and then click Next. 

7. On the Select Path page, click Next. 

8. On the Select Networks page, in the Virtual Network list, click VMM Network. 

9. Click Next. 

10. On the Additional Properties page, click Next. 

11. On the Summary Page, click Create. 

12. The Jobs window opens. Review the jobs required to create the virtual machine. When all the jobs 
complete, close the Jobs window. 

Results: After this exercise, you should have converted LON-EX-01 to a VMM compatible format. 
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Exercise 6: VMM Administration 

► Task 1: View job information 

1. In the left pane, click Jobs. 

2. In the details pane, click Virtual-to-virtual conversion. 

3. At the bottom of the details pane, click the Details tab, and then review the steps and progress. 

4. Click the Change Tracking tab. 

5. Review the Property, Previous Value, and New Value information. 

► Task 2: Set placement defaults for virtual machines 

1. In the left pane, click Administration, and then click General. 

2. In the details pane, double-click Placement Settings. 

3. The Placement Settings dialog box appears. Set Memory free to Very Important. 

4. Set Network Utilization to Very Important. 

5. Click OK. 

► Task 3: Grant user remote access 

1. In the details pane, double-click Remote Control. 

2. The Remote Control dialog box appears. Click Add. 

3. In the Enter the object name to select field, type Administrator. 

4. Click Check Names. 

5. Click OK twice. 

Results: After this exercise, you should have viewed job details, set placement defaults for virtual 
machines and granted the user Administrator remote control. 
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Lab Answer Keys 
Lab A: Using the VMM Library 

Exercise 1: Configure Library Resources 

► Task1: Show hidden files and folders 

1. Restore Windows Explorer. 

2. On the Tools menu, click Folder Options. 

3. The Folder Options dialog box appears. Click the View tab. 

4. In the Advanced settings field, under Hidden files and folders, select Show hidden files and 
folders. 

5. Click OK. 

► Task 2: Add a shared folder 

1. Navigate to C:\ProgramData. 

2. On the File menu, click New | Folder. 

3. Type ContosoResources, and then press ENTER. 

4. Right-click ContosoResources, and then click Share. 

5. The File Sharing dialog box appears. Click Share, and then click Done. 

► Task 3: Add a library share 

1. Restore Virtual Machine Manager. 

2. In the left pane, click Library. 

3. In the Resources pane, click 6422-HYPER-V##.contoso.com. 

4. Right-click 6422-HYPER-V##.contoso.com, and then click Add library share. 

5. The Add Library Share wizard appears. Select ContosoResources, and then click Next. 

6. On the Summary page, click Add Library Shares. 

► Task 4: Add resources to the library share 
1. Restore Windows Explorer. 

2. Navigate to E:\Mod04\Labfiles, and then click 6001.18000.080118-1840_amd64fre_Server_en-us-
KRMSXFRE_EN_DVD.iso. 

3. On the Edit menu, click Copy To Folder. 

4. The Copy Items dialog box appears. Navigate to C:\ProgramData\ContosoResources, and then 
click Copy. 

5. Navigate to E:\Hyper-V\Virtual Hard Disks, and then click WS03 VMAdd.vhd. 

6. On the Edit menu, click Copy To Folder. 

7. The Copy Items dialog box appears. Navigate to C:\ProgramData\ContosoResources, and then 
click Copy. 
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► Task 5: Configure library refresh 

1. Restore Virtual Machine Manager. 

2. In the Resources pane, click 6422-HYPER-V.contoso.com | ContosoResources. 

3. In the Actions pane, click Library settings. 

4. The Library Settings dialog box appears. In the Library refresh interval (hours) field, type 2, and 
then click OK. 

► Task 6: Manually refresh library share 

• In the Library Servers pane, right-click ContosoResources, and then click Refresh. 

Results: After this exercise, you should have created a shared folder, added the library share for the 
folder to VMM, and then added resources to the VMM library. 

Exercise 2: Work with Templates 

► Task 1: Create a template 

1. In the Actions pane, click New template. 

2. The New Template Wizard appears. Click From an existing virtual machine currently located on 
a host. 

3. Click Browse. 

4. The Select Template Source dialog box appears. Click SEA-WRK-001, and then click OK. 

5. Click Next. 

6. The Virtual Machine Manager dialog box appears. Review the message, and then click Yes. 

7. On the Template Identity page, in the Template name field, type Contoso Windows Server 2003. 

8. Click Next. 

9. On the Configure Hardware page, click Next. 

10. On the Guest Operating System page, under Networking, click Domain / Workgroup. 

11. Click Domain. 

12. In the Domain field, type Contoso. 

13. In the Domain user field, type contoso\administrator. 

14. In the Password and Confirm fields, type Pa$$w0rd. 

15. Under General Settings, click Admin Password. 

16. In the Password and Confirm fields, type Pa$$w0rd. 

17. Click Next. 

18. On the Select Library Server page, click Next. 

19. On the Select path page, click Browse. 

20. The Select Destination Folder dialog box appears. Click ContosoResources, and then click OK. 

21. Click Next. 

22. On the Summary page, click Create. 
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23. In the left pane, click Jobs. 

24. In the details pane, click Create template. 

25. Click the Details tab, and then review the steps and status of the template creation. When the job 
completes, continue with the next task. 

► Task 2: Create a VM from a template 

1. In the Actions pane, click New virtual machine. 

2. The New Virtual Machine wizard appears. Click Browse. 

3. The Select Virtual Machine Source dialog box appears. Click Contoso Windows Server 2003, and 
then click OK. 

4. Click Next. 

5. On the Virtual Machine Identity page, in the Virtual machine name field, type SEA-APP-02. 

6. Click Next. 

7. On the Configure Hardware page, click Next. 

8. On the Guest Operating System page, click Identity Information. 

9. In the Computer name field, type SEA-APP-02. 

10. Click Admin Password. 

11. In the User name field, type Admin. 

12. Click Product Key. 

13. In the Product Key field, type XXXXX-XXXXX-XXXXX-XXXXX-XXXXX. 

14. Click Next. 

15. On the Select Destination page, click Next. 

16. On the Select Host page, click Next. 

17. On the Select Path page, click Next. 

18. On the Select Networks page, click Next. 

19. On the Additional Properties page, click Next. 

20. On the Summary page, click Create. 

21. The Jobs window opens. Click Create virtual machine. 

22. Review the steps and status of the virtual machine creation. Continue with the next exercise as this 
process completes in the background. 

Results: After this exercise, you should have created a new virtual machine named SEA-APP-01 from the 
Contoso Windows Server 2003 template. 

Exercise 3: Create Profiles 

► Task 1: Create a hardware profile 

1. Restore Virtual Machine Manager. 

2. In the left pane, click Library. 
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3. In the Actions pane, click New hardware profile. 

4. The New Hardware Profile dialog box appears. In the Name field, type Default Hardware Profile. 

5. Click the Hardware Settings tab. 

6. In the Network location list, click Internal Network. 

7. Click the Network Adapter toolbar button, and then click Synthetic network adapter. 

8. In the left pane, click Memory. 

9. In the Virtual machine memory field, type 256. 

10. Click OK. 

► Task 2: Create a guest operating system profile 

1. In the Actions pane, click New guest OS profile. 

2. In the Name field, type Default Guest OS Profile. 

3. Click the Guest OS tab. 

4. Click Admin Password. 

5. In the Password and Confirm fields, type Pa$$w0rd. 

6. Click Product Key. 

7. In the Product Key field, type XXXXX-XXXXX-XXXXX-XXXXX-XXXXX. 

8. Click Operating System. 

9. In the Operating system list, click 64-bit edition of Windows Server 2008 Standard. 

10. Click OK. 

Results: After this exercise, you should have created a hardware profile named Default Hardware Profile, 
and a guest operating system profile named Default Guest OS Profile. 

Exercise 4: Deploy a Virtual Machine from the Library 

► Task 1: Create a new VM in the library 

1. In the Actions pane, click New virtual machine. 

2. The New Virtual Machine wizard appears. Select Create the new virtual machine with a blank 
virtual hard disk. 

3. Click Next. 

4. On the Virtual Machine Identity page, in the Virtual machine name field, type SEA-APP-03. 

5. Click Next. 

6. On the Configure Hardware page, click Next. 

7. On the Select Destination page, select Store the virtual machine in the library. 

8. Click Next. 

9. On the Select Library Server page, click Next. 

10. On the Select path page, click Browse. 
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11. The Select Destination Folder dialog box appears. Click ContosoResources, and then click OK. 

12. Click Next. 

13. 13. On the Summary page, click Create. 

► Task 2: Deploy a VM from the Library 

1. Restore Jobs. 

2. Click Create virtual machine. 

3. Review the results under the Details tab. If this job is still running, wait for the job to complete before 
continuing to the next step. If the job is taking too long to complete, continue to the next exercise. 

4. In the left pane, click Library. 

5. In the details pane, click SEA-SRV-01. 

6. In the Actions pane, click Deploy. 

7. The Deploy Virtual Machine wizard appears. Click Next. 

8. On the Select Path page, click Next. 

9. On the Select Networks page, click Next. 

10. On the Summary page, click Deploy. 

Results: After this exercise, you should have created a hardware profile named Default Hardware Profile, 
and a guest operating system profile named Default Guest OS Profile. 

Exercise 5: Create a Self-Service Policy 

► Task 1: Create a self-service user role 

1. Restore Virtual Machine Manager. 

2. In the left pane, click Administration. 

3. In the Administration pane, click User Roles. 

4. In the Actions pane, click New user role. 

5. The Create User Role wizard appears. In the User role name field, type Self-Service Users. 

6. Click Next. 

7. On the Add Members page, click Add. 

8. The Select Users or Groups dialog box appears. In the Enter the object names to select field, type 
Administrator. 

9. Click Check Names, and then click OK. 

10. Click Next. 

11. On the Select Scope page, select Contoso, and then click Next. 

12. On the Virtual Machine Permissions page, click Only selected actions. 

13. Clear the check boxes for Remove, Remote connection and Shutdown. 

Note: The following should be selected: Start, Stop, Pause and resume, Checkpoint, Local 
administrator. 



 Managing the VMM Virtual Machine Image Library and Checkpoints 8-7 

14. Click Next. 

15. On the Virtual Machine Creation Settings page, select Allow users to create new virtual 
machines. 

16. Click Add. 

17. The Select a Template dialog box appears. Click Contoso Windows Server 2003, and then click OK. 

18. Select Set quota for deployed virtual machines. 

19. In the Maximum quota points allowed field, type 10. 

20. Click Next. 

21. On the Library Share page, select Allow users to store virtual machines in a library. 

22. Click Browse. 

23. The Select Destination Folder dialog box appears. Click ContosoResources, and then click OK. 

24. Click Next. 

25. On the Summary page, click Create. 

► Task 2: Open the self-service portal 

1. On the Start menu, click All Programs | Microsoft System Center | Virtual Machine Manager 
2008 | Virtual Machine Manager Self-Service Portal. 

2. The Internet Explorer window opens. In the Domain\username field, type 
Contoso##\administrator. 

3. In the Password field, type Pa$$w0rd. 

4. Click Log On. 

► Task 3: Create a New VM 

1. In the left pane, click New Computer. 

2. The New Virtual Machine – Windows Internet Explorer window opens. In the Name field, type SEA-
APP-03. 

3. In the Computer Name field, type SEA-APP-03. 

4. In the Administrator Password and Confirm Password fields type, Pa$$w0rd. 

5. In the OS Product Key field, type XXXXX-XXXXX-XXXXX-XXXXX-XXXXX. 

6. Click Create. 

7. The Windows Internet Explorer dialog box appears. Click OK. 

8. Close Internet Explorer. 

Results: After this exercise, you should have created a self-service user role, logged onto the Self-Service 
Portal as bhoffman and created a new VM. 
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Lab B: Managing Checkpoints 

Exercise 1: Perform Checkpoint Operations 

► Task 1: Create a checkpoint 

1. Restore Virtual Machine Manager. 

2. In the left pane, click Virtual Machines. 

3. In the details pane, click SEA-SQL-01. 

4. In the Actions pane, click New checkpoint. 

5. The New Checkpoint dialog box appears. Click Create. 

► Task 2: View checkpoint properties 

1. In the Actions pane, click Manage checkpoints. 

2. The Virtual Machine Properties for SEA-SQL-01 dialog box appears. Under Available checkpoints, 
click the SEA-SQL-01. 

3. Click Properties. 

4. The Properties For Checkpoint SEA-SQL-01 dialog box appears. Click OK. 

► Task 3: Create a new checkpoint from the properties dialog box 

1. Click New. 

2. The New Checkpoint dialog box appears. In the Name field, type SEA-SQL-01 Second Checkpoint, 
and then click Create. 

► Task 4: Delete a checkpoint 

1. Under Available Checkpoints, click SEA-SQL-01 Second Checkpoint. 

2. Click Remove. 

3. The Virtual Machine Manager dialog box appears. Click Yes. 

► Task 5: Restore a VM to a checkpoint 

1. Under Available checkpoints, click SEA-SQL-01. 

2. Click Restore. 

3. The Virtual Machine Manager dialog box appears. Click Yes. 

4. Click OK. 

Results: After this exercise, you should have created a new checkpoint, viewed the properties of a 
checkpoint, deleted a checkpoint and then restored a VM to a checkpoint. 
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Lab Answer Keys 
Lab A: Using PowerShell with VMM 

Exercise 1: Introduce the VMM Command Shell 

► Task1: Open the VMM command shell from the Start menu 

1. On the Start menu, click All Programs | Microsoft System Center | Virtual Machine Manager 
2008 | Windows PowerShell – Virtual Machine Manager. 

2. The Windows PowerShell window opens. If the Do you want to run software from this untrusted 
publisher prompt appears, type A, and then press ENTER. 

► Task 2: Display Help topics 

1. Type Get-Help about_VMM, and then press ENTER. Review the output. 

2. Type Get-Help about_VMM_Tutorial, and then press ENTER. Review the output. 

3. Type Get-Help about_VMM_Scripting, and then press ENTER. Review the output. 

► Task 3: View Help topics as a text file 

1. Type Get-Help about_VMM | out-file c:\about_VMM.txt, and then press ENTER. 

2. Type notepad C:\about_VMM.txt, and then press ENTER. 

3. The Notepad window opens. Read through the text file. 

4. Close Notepad. 

5. Type Get-Help about_VMM_Tutorial | out-file c:\about_VMM_tutorial.txt, and then press ENTER. 

6. Type notepad C:\about_VMM_tutorial.txt, and then press ENTER. 

7. The Notepad window opens. Read through the text. 

8. Close Notepad. 

Results: After this exercise, you should have viewed help information for VMM PowerShell topics and 
saved the help topics to text files. 

Exercise 2: Use Basic PowerShell Cmdlets 

► Task 1: List all PowerShell Cmdlets 

1. Restore Windows PowerShell. 

2. Type Get-Command, and then press ENTER. 

► Task 2: Use PowerShell to manage services 

1. Type get-service, and then press ENTER. 

2. Type stop-service –name VMMAgent, and then press ENTER. 

3. Type start-service –name VMMAgent, and then press ENTER. 

Results: After this exercise, you should have successfully stopped and started the Virtual Machine 
Manager Agent service. 
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Exercise 3: Use VMM Cmdlets 

► Task 1: List VMM Cmdlets 

1. Type Get-Command –PSSnapin Microsoft.SystemCenter.VirtualMachineManager, and then press 
ENTER. 

2. Type Get-Help New-VM -detailed, and then press ENTER. 

► Task 2: Connect to the VMM server 

• Type Get-VMMServer –Computername “6422-Hyper-V##.contoso##.com”, and then press 
ENTER. 

► Task 3: Display specific properties of the VMM server 

• Type Get-VMMServer –Computername “6422-Hyper-V##.contoso##.com” | Format-List –
property Name, FullyQualifiedDomainName, PlacementGoal, MemoryPriority, DiskIOPriority, 
CPUPriority, NetworkPriority, and then press ENTER. 

► Task 4: Display all properties available for the VMM server 

1. Type $VMMServer = Get-VMMServer –Computername “6422-Hyper-V##.contoso##.com”, and 
then press ENTER. 

Note: In PowerShell the $ symbol signifies a variable. In this example, you are storing the output in the 
VMMServer variable. 

2. Type $VMMServer | Get-Member, and then press ENTER. 

► Task 5: Create a VM checkpoint 

1. Type $Checkpoint = Get-VM | where {$_.Name –eq “SEA-SQL-01”} | New-VMCheckpoint. 

2. Type $Checkpoint, and then press ENTER. 

► Task 6: Start a VM 

• Type start-vm –vm “SEA-SRV-02”, and then press ENTER. 

► Task 7: Get a list of failed jobs on a VMM server 

• Type Get-Job | where {$_.Status –eq “Failed”} | Format-List –property Name, ID, Status, and 
then press ENTER. 

Note: There may not be any failed jobs listed. The command will complete successfully if you don’t 
receive any errors. 

► Task 8: Backup VMM server 

• Type backup-vmmserver –path “c:\users\administrator”, and then press ENTER. 

Results: After this exercise, you should have successfully viewed properties of the VMM Server, created 
a Checkpoint for SEA-DC-02, started SEA-DC-02, viewed a list of failed jobs and backed up the VMM 
server. 

Exercise 4: PowerShell Scripts in VMM Wizards 

► Task 1: Start the Add Library Share Wizard 

1. Minimize Windows PowerShell. 
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2. Restore Windows Explorer, and then navigate to E:\. 

3. On the File menu, click New | Folder. 

4. Type NewLibrary, and then press ENTER. 

5. Right-click NewLibrary, and then click Share. 

6. The File Sharing dialog box appears. Click Share, and then click Done. 

7. Restore Virtual Machine Manager. 

8. In the left pane, click Library. 

9. In the Library Servers pane, right-click 6422-Hyper-V##.contoso##.com, and then click Add 
library shares. 

10. The Add Library Share wizard appears. Select NewLibrary, and then click Next. 

► Task 2: Save Add Library Share Wizard script 

1. On the Summary page, click View Script. 

2. The Notepad window opens. On the File menu, click Save As. 

3. The Save As dialog box appears. In the File Name field, type Add_Library_Share.ps1. 

4. In the Save as type field, select All Files. 

5. Click Save, and then close Notepad. 

6. In the Add Library Share wizard, click Cancel. 

7. The Virtual Machine Manager dialog box appears. Click Yes. 

► Task 3: View execution policy 

1. Restore Windows PowerShell – Virtual Machine Manager. 

2. Type get-executionpolicy, and then press ENTER. 

► Task 4: Set execution policy 

• Type set-executionpolicy unrestricted, and then press ENTER. 

Note: This is a not a secure setting and should only be used in testing scenarios. 

► Task 5: Verify execution policy 

• Type get-executionpolicy, and then press ENTER. 

► Task 6: Run Add_Library_Share.ps1 script 

• Type c:\users\administrator\documents\ Add_Library_Share.ps1, and then press ENTER. 

► Task 7: Verify new library share 

1. Restore Virtual Machine Manager. 

2. In the left pane, right-click 6422-Hyper-V##.Contoso##.com, and then click Refresh. 

3. Click NewLibrary. 
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Results: After this exercise, you should have saved the PowerShell script from the Add Library Wizard 
and then ran the script successfully. 

Exercise 5: Create a Simple VMM Script 

► Task 1: Create Get-VM.ps1 

1. Restore Windows PowerShell. 

2. Type Set-Location c:\users\administrator, and then press ENTER. 

3. Type notepad Get-VM.ps1, and then press ENTER. 

4. The Notepad dialog box appears. Click Yes. 

5. The Notepad window opens. Type the following: 

# filename: Get-VM.ps1 
Write-Host 
write-host –backgroundColor blue “The following are virtual 
machines located on SEA-Hyper-V##:” 
get-vm –vmmserver 6422-hyper-v##.contoso##.com | format-list – 
property Name, Owner, Description, OperatingSystem 
Write-Host 
# end of script 

► Task 2: Save Get-VM.ps1 

1. On the File menu, click Save. 

2. Close Notepad. 

► Task 3: Run Get-VM.ps1 

1. Type .\Get-VM, and then press ENTER. 

2. Type exit, and then press ENTER. 

Results: After this exercise, you should have created and ran a PowerShell script that listed the virtual 
machines located on 6422-Hyper-V. 
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Lab B: Creating Backups 

Exercise 1: Use Windows Server Backup to Backup Virtual Machines 

► Task 1: Install Windows Server Backup 

1. Restore Server Manager. 

2. In the console pane, click Features. 

3. In the right pane, click Add Features. 

4. The Add Features Wizard appears. Expand Windows Server Backup Features, and then select 
Windows Server Backup. 

5. Click Next. 

6. On the Confirm Installation Selections page, click Install. 

7. On the Results page, click Close. 

► Task 2: Schedule a backup 

1. In the console pane, expand Storage, and then click Windows Server Backup. 

2. In the Actions pane, click Backup Once. 

3. The Backup Once Wizard appears. Click Next. 

4. On the Select backup configuration page, click Custom, and then click Next. 

5. On the Select backup items page, click Next. 

6. On the Specify destination type page, click Next. 

7. On the Select backup destination page, in the Backup destination list, click Local Disk (E:). Click 
Next. 

8. On the Specify advanced options page, click Next. 

9. On the Confirmation page, click Backup. 

Results: After this exercise, you should have scheduled a backup using the Backup Once Wizard. 
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Send Us Your Feedback 
You can search the Microsoft Knowledge Base for known issues at Microsoft Help and Support before 
submitting feedback. Search using either the course number and revision, or the course title. 

 

Note Not all training products will have a Knowledge Base article – if that is the case, please ask your 
instructor whether or not there are existing error log entries.  

 

Courseware Feedback 
Send all courseware feedback to support@mscourseware.com. We truly appreciate your time and effort. 
We review every e-mail received and forward the information on to the appropriate team. Unfortunately, 
because of volume, we are unable to provide a response but we may use your feedback to improve your 
future experience with Microsoft Learning products. 

 

Reporting Errors 
When providing feedback, include the training product name and number in the subject line of your e-
mail. When you provide comments or report bugs, please include the following: 

• Document or CD part number  

• Page number or location  

• Complete description of the error or suggested change  

Please provide any details that are necessary to help us verify the issue. 

 

Important All errors and suggestions are evaluated, but only those that are validated are added to the 
product Knowledge Base article.  

 

http://go.microsoft.com/fwlink/?LinkId=64183�
mailto:support@mscourseware.com�
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